Developing an Effective Resume

A resume is a concise, organized summary of your skills, accomplishments, experiences, and

education, which is designed to capture the interest of a potential employer.

e A resume should be tailored specifically for the kind of job/organization/career you are seeking. This
means you may have to write more than one resume if applying for different types of jobs.

e The purpose of a resume is to secure an interview.

e In writing a resume, “one size does not fit all.” Don’t try to make your resume look like everyone
else’s. For this reason, don’t use a resume template.

e There are many different ways of constructing an effective resume, depending on the type of skills,
work experiences, accomplishments, activities, and so forth that you want to emphasize as being
related to your career/job preferences.

BEFORE YOU CAN WRITE AN EFFECTIVE RESUME, you must first be able to identify your skills,
abilities, and interests and be able to relate them to the job/industry/career field in which you are seeking

employment.

If you are unsure about the types of jobs, industries, organizations, or careers you are targeting, make an
appointment with Career Services to help you in developing some focus. Employers cannot (and will not)
decide what career is best for you; you must be able to communicate what skills and abilities you have
that fit the specific job or jobs they are trying to fill.

1. Be sure your resume
communicates your abilities, as
well as your personal qualities that
pertain to the job. These abilities
may have come from activities,
education, volunteer work, or from
work experience.

2. Focus on the employer’s
needs, not on your own needs.

3. Be concise.

Keep it simple and to the point.

An employer must be able to read
over your resume quickly (30 — 60
seconds)!

4. Eliminate the first person
pronoun “I” from your resume.
For example, “ | am seeking a
position in human services...”
should read “Seeking position in
human services...”

5. Quantify your experience
wherever possible. For example,
“Supervised others” can be made
more clear by stating “Supervised
three cash register attendants”.

6. Be consistent.

The order of information, spacing,
format, or highlighting should be
consistent throughout your resume.

7. Use action verbs in describing your
skills and experience.

Instead of...Responsible for assisting
with preparation of sales tax reports
each month

Write......... Assisted in preparation of
monthly sales tax reports

Instead of...Was in charge of organizing
and taking care of spring rush activities
Write......... Organized and directed
spring rush activities for more than 50
new sorority pledges

8. Write a draft of your resume, then
refine and polish it. Writing an effective
resume takes some time and effort.

9. Check your grammar and spelling!
Have at least one other person
proofread your resume before submitting
it to an employer.

10. Keep the resume to one page.
A resume should only be two pages if
you have a great deal of related
experience, activities, or training.
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Resume

RESUME FORMATS

CHRONOLOGICAL

e Use if your education and/or experience closely relates to your career goals
e |ists education and work experience in reverse chronological order (most recent information in each section first)

e  Most commonly used resume format

FUNCTIONAL

e Puts greater emphasis on SKILLS and less on work history or educational background
o Effective when work experience does not show a direct relationship to the career goal or when there are

significant gaps in experience
COMBINATION

e Typically shows a short skills summary, while
retaining the reverse chronological order on
education and experience sections

CURRICULUM VITAE

e Required for teaching/research positions in higher
education

e |s a more comprehensive and detailed account of
one’s background, and is usually much longer than a
resume

SCANNABLE RESUMES

Many employers are now using electronic databases to
store the large numbers of resumes they receive.
Resumes are electronically scanned into a database; the
database can then be searched for applicants that meet
specific job requirements. If asked for a “scannable
resume,” follow these tips:

e Use “keywords” or phrases applicable to the career
field or related to the job sought.

e Use a standard font style sized between 10-12 points.

Avoid ornate fonts and those where the characters
touch.

e Do not use italics or underlining. Use boldface for
emphasis.

e Avoid graphics and shading. Use asterisks (*)
instead of “bullets.”

e Do not double space between sections.

e The resume should be an original, printed on white or
light-colored paper. Do not fold or staple the resume.

For more information about scannable resumes, ask for
the “Going Digital: Plain Text and Scannable Resumes”
guide, available in Career Services.

Resume Do’s & Don’ts

Use conservative font styles (Times New Roman,
Arial, Arial Narrow, or similar styles). Font size may
range from 10-12.

Set page margins between 0.5 and 1.0 inches (top,
bottom, left and right).

Print your resume using a laser printer; white or off-
white bond paper is preferred. (Dark paper does not
copy or fax well!)

Keep your resume up to date, with correct addresses
and phone numbers!

ALWAYS include a cover letter when mailing your
resume to an employer.

DON’T
Don’t make handwritten corrections.
Don’t include: age, marital status, height/weight, birth
date, or a photograph.
Don’t abbreviate (other than for the states - SC).

Don’t exaggerate or lie on your resume. It will catch
up with you.

Office of Career Services




What to Include

OBJECTIVE

EDUCATION

EXPERIENCE

SKILLS

INTERESTS

REFERENCES

Your full name (in all capital letters and/or bold)
Complete address (list permanent and present addresses if in college)
Home and/or mobile phone numbers

E-mail address (Make sure your email address does not sounds unprofessional.)

The career objective tells an employer how you fit in the organization. It forces you
to focus on your job interest, and it unifies the rest of your resume. Three pieces of
information make up the objective:

1. The level or type of position (Example: entry level, sales trainee, social worker)

2. Where the job is located in the organization or industry (Example: international
news, marketing department)

3. Interests, knowledge, or skills you wish to share or hope to incorporate into your
work

Examples:

“To obtain an entry-level position in human resource management with particular

interests in wage and salary administration”

“Programmer position requiring knowledge of Visual Basic, C++, and JavaScript”

“Professional position in higher education utilizing skills in administration, program

development and counseling”

e Avoid double objectives: This can cause an employer to wonder if you really know
what you want. Use two separate resumes if you have more than one career
direction.

e Leave out phrases like “opportunity for advancement” or “challenging, rewarding
position.” These objectives only tell the company what you expect from them
(“What's in it for me?”). Rather, tell the company what you are going to do for them.

This section may contain the following: names and locations of schools or
programs; graduation date (or expected date); degrees, certificates, or licenses;
major; grade point average IF 3.0 or above; coursework related to the job you
want; awards or scholarships; and/or, study abroad experiences. These may
also be separate sections in your resume.

Be sure that you cover full-time, part-time, summer and volunteer work, military
service, internships, and self-employment. However, it is not necessary to list
every job you've ever had. If you have had a lot of work experience, limit the jobs
you list to the three or four you consider the most important as learning experiences.
Include your job title; employer name (company/organization); dates of
employment; and bulleted, active descriptions of your responsibilities and major
accomplishments.

(OR ACTIVITIES OR HONORS) You may want to mention interests and activities
that demonstrate job-related skills (leadership, organization, etc.); special
abilities, such as knowledge of computers or a foreign language; and/or honors

or awards earned. Do not include personal data, such as age and health status.

These are optional. Include only if you have space and/or your interests are unique
or demonstrate mastery of a skill.

Indicate that references are available but do not list them on your resume (use the
phrase “Available upon request”). Then list 3-5 references on a separate page that
is the same type of paper as your resume.
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Action Verbs

accelerated
accounted for
accomplished
achieved
acquired
acted
addressed
adapted
adjusted
administered
advanced to
advertised
advised
aided
allocated
analyzed
answered
anticipated
applied
arranged
articulated
ascertained
assembled
assessed
assigned
assisted
assured
attained
attended
audited
authored
authorized
balanced
began
bought
brought
budgeted
built
calculated
carried out
catalogued
categorized
chaired
challenged
changed
clarified
classified
coached
coded
collaborated
collected
committed
communicated
compared

completed
composed
computed
concluded
conducted
confronted
constructed
contacted
continued
contracted
contributed
controlled
conveyed
cooperated
coordinated
corrected
corresponded
counseled
created
critiqued
dealt (with)
defined
delegated
delivered
demonstrated
derived
designed
described
detected
determined
developed
devised
diagnosed
directed
discovered
discussed
displayed
distributed
drafted
drew
earned
edited
educated
elicited
employed
empowered
enabled
encouraged
enlisted
ensured
entertained
escalated
established
estimated

evaluated
examined
excelled
executed
exercised
exhibited
expanded
expedited
experimented
explained
expressed
facilitated
filed
financed
followed
forecasted
formed
formulated
founded
functioned
furnished
generated
governed
graded
guided
handled
headed
helped
identified
illustrated
imagined
implemented
imposed
improved
inaugurated
increased
influenced
initiated
innovated
inquired
inspected
installed
instilled
instructed
insured
interacted
interpreted
intervened
investigated
involved
joined
judged
justified
kept

learned
lectured
led

located
made
maintained
managed
manipulated
marketed
mastered
measured
mediated
mentored
met
mobilized
modified
monitored
motivated
negotiated
observed
obtained
operated
ordered
organized
originated
outlined
oversaw
participated
perceived
performed
persuaded
planned
played
possessed
predicted
prepared
presented
processed
produced
programmed
projected
promoted
proofread
proposed
provided
publicized
published
rated
realigned
recognized
recommended
reconciled
recorded
recruited

referred
related
reorganized
reproduced
researched
resolved
responded
restored
retrieved
reviewed
revised
risked
scheduled
searched
selected
served
serviced
set

shaped
shared
showed
simplified
skilled

sold
solicited
solved
sought
specified
spoke
staged
streamlined
strengthened
studied
succeeded
suggested
summarized
supervised
supported
surveyed
tabulated
taught
tested
trained
translated
tutored
updated
upgraded
used
utilized
verified
visualized
volunteered
won

wrote
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OBJECTIVE

EDUCATION

HONORS

EXPERIENCE

SKILLS

ACTIVITIES

REFERENCES

SAMPLE CHRONOLOGICAL RESUME

JOSEPH FAULKNER
232 Oak Lane
Charleston, SC 29412
(843) 123-4567
jfaulkner@edisto.cofc.edu

To contribute my skills in writing, analysis, and research to a position in publishing

Bachelor of Arts in English, May 2006
College of Charleston, Charleston, SC
Major GPA 3.2/4.0 Overall GPA 3.0/4.0

Courses taken include:
Advanced Composition Advanced Creative Writing
Writing for the Mass Media Electronic Publishing and Design

Highly Distinguished Honor Student
Member of Phi Kappa Phi (Interdisciplinary Honor Society)

Language Lab, College of Charleston, Charleston, SC

Lab Assistant, January 2005 - present

e  Assist students and professors with setting up and operating audio visual materials and
equipment

e Maintain inventory, provide customer service and enter daily activities into a computer
database

George Street Observer, College of Charleston, Charleston, SC

Staff Writer, August 2004 - present

e Wrote several special interest and newspaper articles for College of Charleston weekly
newspaper with a circulation of approximately 8000 readers

J. C. Jansen & Co., P.A., Charleston, SC
Courier/Office Assistant, Summer 2004

e Received and delivered official documents
e Assisted paralegals in legal research; proofread letters and documents

Computer proficiency in Microsoft programs including Word, Access, PowerPoint;
PageMaker; Quark Xpress; and internet applications

Excellent research and editing skills

Charleston County Library Book Exchange, February 2005
e  Volunteer for program involved in selling and exchanging used books

Charleston Citizen Participation and Clean City Commission, March 2004 - present
e Perform general administrative duties and assisted with Clean City Sweep Campaign

Available upon request

This is an example of a resume in Chronological Style, which is the most common style used.
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SAMPLE PLAIN-TEXT/SCANNABLE RESUME
JOSEPH FAULKNER

232 Oak Lane
Charleston, SC 29412
843 123 4567
jfaulkner@edisto.cofc.edu

KEYWORD SUMMARY

Copy editing. Creative writing. Journalism. Technical writing. Publishing. Research. English major. Microsoft
Word. Microsoft Access. Microsoft Publisher. Aldus PageMaker. QuarkXPress.

OBJECTIVE
To contribute skills in writing, analysis, and research to a position in publishing.
EDUCATION

Bachelor of Arts in English, May 2006

College of Charleston, Charleston, SC

Major GPA 3.2/4.0 Overall GPA 3.0/4.0

Advanced Composition. Advanced Creative Writing. Writing for the Mass Media. Electronic Publishing and Design.

HONORS

Highly Distinguished Honor Student
Member of Phi Kappa Phi Interdisciplinary Honor Society

EXPERIENCE

Language Lab, College of Charleston, Charleston, SC

Lab Assistant

January 2005 - present

Assist students and professors with audio visual materials and equipment

Maintain inventory, provide customer service and enter daily activities into a computer database

George Street Observer, College of Charleston, Charleston, SC

Staff Writer

August 2004 - present

Wrote several special interest and newspaper articles for College of Charleston newspaper with a
circulation of approximately 8000 readers

J. C. Jansen Law Firm, Charleston, SC

Couirier, Office Assistant

Summer 2004

Received and delivered official documents

Assisted paralegals in legal research; proofread letters and documents

SKILLS
Computer proficiency in Microsoft programs including Word, Access, PowerPoint, PageMaker, Quark Xpress, Net-

scape, Microsoft Explorer
Excellent research and typing skills

Note: Resumes in scannable format are often more than one page; that is acceptable
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Objective

Related Skills

Education

Activities

Work Abroad
Experience

Experience

SAMPLE COMBINATION RESUME

Rebecca Smith
311 Mimosa Lane
Charleston, SC 29401
(843)577-0002
smithr@edisto.cofc.edu

A public relations position requiring well-developed communication, administrative, and
organizational skills

Experience in designing marketing research studies and surveys
Comfortable with public speaking; excellent oral and written communication skills
Computer literate in Microsoft Office programs; QuarkXPress; and PageMaker

College of Charleston, Charleston, SC
Bachelor of Science in Corporate Communication, May 2005
Minor: Business Administration

Study Abroad
Nene College, Northhampton, England
Combined Honours Programme, January - April 2004

College of Charleston

Student Alumni Ambassador, 2000 - 2005

e Assisted with Open House

e Gave tours of the President's historic home

Zeta Tau Alpha Sorority, 2001- 2005
e SPCA Volunteer
e Charleston Children's Fair volunteer

Collége Francois Premier, Villers-Cotteréts, France

Foreign Language Assistant, May - August 2003

e Strengthened French communications skills by living with a native family
e Organized, planned, and taught classes in a foreign language program

Kirkman Sports Marketing, Charleston, SC

Intern, Spring Semester 2003

e Created and sold marketing plans to clients

e Gained considerable experience organizing and assisting in all station promotions
e Developed and voiced commercials

First Mortgage Services, Inc., Charleston, SC

Customer Service Representative, August 2001- May 2002

e Answered customer inquiries regarding mortgage services

e Provided assistance in completing necessary forms

e Aided in the design and development of marketing plans

e Revised all investor processing forms and employee handbook

Note: Rebecca chose to add a "Related Skills" section to point out several skills needed in the
Public Relations field; she also wanted to emphasize her work/study abroad experience.
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SAMPLE FUNCTIONAL RESUME

BENJAMIN RUSSELL

25 Old Towne Road, North Charleston, SC 29414
(843) 223-8902 home

(843) 406-1234 mobile

OBJECTIVE
To use my marketing, managerial and communication skills in a sales representative position

SKILLS AND ACCOMPLISHMENTS
Sales and Marketing
e Worked as a sales clerk in a fine men's clothing store, earning commissions on sales
e Awarded "Sales Associate of the Month" three times for exceeding sales goals
e Assisted in promotions of sales activities through in-store merchandising, advertising, and
individual contact with repeat customers

Leadership

e Elected president of Sigma Alpha Epsilon fraternity during the 2004-2005 year

e Delegated responsibilities to committee members and evaluated progress toward achieving goals

o Worked with Interfraternity Council, student groups, and college administration in order to
maintain a good working relationship with the college and with the community

Management

e Learned effective time management through working part-time while participating in campus
activities and carrying a full course load

¢ Gained experience in goal setting, plan development, and follow-up methods while serving as
fraternity president

e Accustomed to accepting responsibility and to working effectively with people at all levels of
an organization

EXPERIENCE
Ben Silver, Charleston, SC
Sales Associate, August 2003 - May 2005

Eckerd Drug Store, Walterboro, SC
Stock Clerk, Summer 2003

Johnson's Home Construction, Walterboro, SC
Construction Worker, Summers 2001 & 2002

EDUCATION
College of Charleston, Charleston, SC
Bachelor of Science in Psychology, May 2005

REFERENCES
Available upon request

Note: Ben's work experience may not appear impressive on its own; so he chose to
highlight his skills and accomplishments in order to better communicate his qualifications for a
sales representative position.
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CAMPUS ADDRESS
18 Central Avenue
Charleston, SC 29402
(843) 789-3654

OBJECTIVE

EDUCATION

RELATED
EXPERIENCE

EXPERIENCE

HONORS AND
SKILLS

REFERENCES

SAMPLE RESUME FOR LIMITED WORK EXPERIENCE

BEA N. TERN
beantern@email.edu

PERMANENT ADDRESS
1449 Jules Avenue
Ravenel, SC 29470

(843) 321-9654

To obtain an internship position in accounting that will benefit from my interest in the
field as well as provide career exploration and experience

Bachelor of Science in Accounting
College of Charleston, Charleston, SC
Candidate for graduation May 2006

Coursework includes: Financial Accounting
Elementary Statistics

College of Charleston, School of Business, Charleston, SC

Student Researcher, Managerial Accounting, January 2005-May 2005

. Researched and wrote a term paper comparing accounting systems in a local
non-profit organization and private industry

Lowcountry Pedalers, Charleston, SC
Rickshaw Driver, May 2003 - present

. Operate bicycle-transport business as independent owner/operator
. Handle daily cash flow totaling $750 and above
. Compute daily earnings and record daily usage logs

Ravenel Health Clinic, Ravenel, SC
Volunteer, Summer 2002

) Received and logged client payments for services
° Prepared client paperwork for insurance reimbursement
. Answered telephones and scheduled patient appointments

Computer literate in Windows and Microsoft Office - Word, Excel, PowerPoint,
Outlook, and Publisher
SC Life Scholarship, 2003 - present

Available upon request

Note: Bea doesn’t have much work experience, so she is focusing on the knowledge she has gained
from classes in her major. The few jobs she has held are not related to her objective, but she has

listed the job responsibilities that most closely relate.

Office of Career Services



SAMPLE RESUME FOR NON-RELATED MAJOR

Christine Edwards

School: 178 Green Street, Charleston, SC 29424 (843)788-6783

E-mail: cedwards@edisto.cofc.edu

Permanent: 199 Pleasant Drive, Columbia, SC 29615 (803) 271-2712

Objective

Computer
Skills

Work
Experience

Education

To obtain an internship in information technology utilizing programming
and communication skills

Programming Languages: Java, C++, Visual Basic

Applications: Microsoft Office (Access, Excel, Word, PowerPoint), Adobe
Acrobat 4.0, Adobe PageMaker, Filemaker Pro

Operating Systems: Windows 98, 2000, ME, XP

Information Technology Assistant, September 2005 - present

APAC Manufacturing Company, Charleston, SC

o Assisted Computer Support team in writing a payroll program in C++
language

o Built database in Access in order to maintain employee information
including names, addresses, hire dates, and other necessary
information

o Gained exposure to a variety of software applications, as well as
hardware requirements, in a business setting

Temporary Staff, Summer 2004

Manpower Staffing, Columbia, SC

o Worked in a variety of short-term assignments involving data entry,
word processing, and database management projects

Visitor Greeter, August 2003 - May 2004

Charleston Visitor Center, Charleston, SC

e Provided information about the Charleston area to visitors, answered
questions, gave directions

College of Charleston, Charleston, SC

Bachelor of Arts in Philosophy, Minor in German

Elective coursework in computer science/computer information systems
Currently a junior, will graduate in May 2007

Note: Christine’s major isn't directly related to her job objective, so she put her related
skills and experience first in order to attract the reader’s attention.
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E-mail Resume Tips

E-mail makes it possible for you to respond instantly to an opportunity, but if not
done correctly, your resume may be overlooked or deleted before it is read.

Whenever possible, copy a plain text (ASCII) resume into the body of your email
message, rather than sending your resume as an attachment. Why?

¢ Attachments may contain viruses, particularly if they are in Microsoft Word.

e Firewalls may stop email attachments from entering a company network.

¢ Recruiters may not take the time to open the attachment.

CREATE AN ASCII / PLAIN TEXT RESUME AND COVER LETTER

A text (or ASCII) resume will be stripped of formatting features such as bold and italics, so it may not appear very
attractive to you. However, it will be universally compatible with all systems. To convert your resume from MS
Word to plain text:

e Open your resume document, go to Edit > Select All and change the font to Courier 12 point; go to File >
Page Setup and change the left and right margins to 1.5 inches

Go to File > Save As > under “Save as Type,” select “Text Only with Line Breaks.”

Select “yes” at the prompt that warns about features being compatible.

Name and save this file, then reopen the file, which should now have a text (.txt) extension

Review and clean up your document:
- Insert space where necessary - Left-justify all text
- Change bullets to asterisks or dashes - Take out tabs and centering
- Change or remove symbols that didn’t convert properly

e  Save your work!

TEST THE FILE

Open your text resume, copy and paste it into your email message box and send it to yourself and a few friends
to ensure that the text transfers properly.

CREATE THE EMAIL MESSAGE

Follow the employers’ directions for applying to each position! Requirements and instructions will differ, based

on the individual company’s needs. If no specific instructions are given:

e Open your email program and set the message format to plain text, not HTML.

e Make the message Subject memorable! ‘My resume” isn’t going to grab the attention of busy person. Make
the subject line relevant, and include your name, e.g. “Resume of Jane Smith — Copy Editor position.”

o Now create a “cover letter” message just as you would in print, except leave off your mailing address, the
date, and the recipient’s mailing address. The message will begin with the salutation, e.g.: “Dear Mr.
Jones:”

e Type your “signature” at the bottom of your “cover letter”. Avoid clever quotations/sayings in your email
signature.

e After your signature, add a couple of blank lines and the text notation.

e Add a couple more blank lines, then paste the text from your ASCII resume into the body of the email
message.
- Unless the employer has requested no attachments, attach your Word resume. This will accommodate
employers who prefer a traditional resume. It doesn’t hurt to send your resume in both formats!

Tip: When posting a resume to an online resume builder,
use your ASCII resume, and cut and paste it to fill the online form.
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Resume Planning Worksheet - Traditional Resume

Identifying information:

first name, middle initial, last name

current address, telephone number, e-mail address

permanent address, telephone number, e-mail address

OBJECTIVE

A (An) x position utilizing my x, y, and z skills OR A position in x that would benefit from my x and y experience

EDUCATION

college, city, state

degree, month, year to be received

major(s), minor(s), concentration(s)

grade point average (if above a 3.0)

related course work (maximum of 6 classes; only if applicable to objective)

EXPERIENCE (volunteer or paid. List most recent experience first.)

title, name of organization, city, state, and dates of employment

leading with an action verb, describe what you did at the organization

describe another responsibility or duty

describe another responsibility or duty

describe another responsibility or duty

(over)
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title, name of organization, city, state, and dates of employment

leading with an action verb, describe what you did at the organization

describe another responsibility or duty

describe another responsibility or duty

title, name of organization, city, state, and dates of employment

leading with an action verb, describe what you did at the organization

describe another responsibility or duty

describe another responsibility or duty

SKILLS (specify computer languages or special skills, including working knowledge, proficiency, or fluency
in languages other than English)

ACTIVITIES (list leadership positions, memberships or affiliations)

name of organization, title or position (if applicable)

name of organization, title or position (if applicable)

HONORS AND AWARDS (if listing awards, tell the employer what the award was for)

name of honor or award, date received

name of honor or award, date received

INTERESTS (only list interests if they would be important to the employer)

REFERENCES Available upon request
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